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CHAPTER 1
Product Overview

1.1 Package Contents

Check the items contained in the package carefully. You should have the following:

o Wireless Internet Camera

o AC Power Adapter.

e Camera Stand.

e Ethernet Cable (RJ-45 type).

o Installation CD-ROM.

o Quick Installation Guide.

NOTE Once any item contained is damaged or missing, contact the authorized dealer of
your locale.



1.2 Introduction

Front View

Internal Microphone
allows the camera to

receive sound

Lens Assembly

and voice.

-

Power LED

Indicates the camera
is powered on with the
steady amber light.

Link LED

indicates the camera’s
network connectivity
with the flashing green
light.



Rear View

Screw Hole
is used to connect
the camera stand.

Ethernet Cable
Connector

is used to connect
the network cable,
which supports the
NWay protocol so
that the camera can
detect the network
speed
automatically.

WPS Button* (for
wireless model)

is used to protect your
wireless network and
for easy wireless
connection setup.

Reset Button will restart
the camera when it is
pressed quickly; when it is
long pressed for five
seconds, the camera will
resume the factory default
settings.

DC Power Connector
is used to connect the

AC power adapter, in
order to supply power
to the camera.

e For more information of the WPS button, refer to the instruction of the Web

Configuration, Network >> Wireless >> WPS Setting.



1.3 Features

= MJPEG codec Supported

The camera provides you with VGA images by the MJPEG codec technology, allowing
you to adjust image size and quality, and bit rate according to the networking
environment.

= 1-way Audio Capability
The built-in microphone of the camera provides on-the-spot audio via the Internet,
allowing you to monitor the on-site voice.

® Remote Control Supported

By using a standard Web browser or the bundled UltraView Pro software application,
the administrator can easily change the configuration of the camera via Intranet or
Internet. In addition, the camera can be upgraded remotely when a new firmware is
available. The users are also allowed to monitor the image and take snapshots via the
network.

® Multiple Platforms Supported

The camera supports multiple network protocols, including TCP/IP, SMTP e-mail, HTTP,
and other Internet related protocols. Therefore, you can use the camera in a mixed
operating system environment, such as Windows Vista and Windows 7.

= Multiple Applications Supported

Through the remote access technology, you can use the cameras to monitor various
objects and places for your own purposes.

For example, babies at home, patients in the hospital, offices and banks, and more. The
camera can capture both still images and video clips, so that you can keep the archives
and restore them at any time.



Specification

Model RSCM-12001 RSCM-12002
Image Sensor
Image Sensor 1/5” Color CMOS Sensor
Resolution 640 X 480
Minimum Illumination 0.7 Lux
Lens
Digital Zoom 3%
Lens Type Board Lens
Aperture (F/No.) 2.8
Focus Length 2.7mm
View Angel(Horizontal) 52.8 Degree
View Angel(Vertical) 39.6 Degree
View Angle(Diagonal) 66 Degree
Night Vision
IR-Cut Filter N/A | Auto

lllumination Distance

N/A | Up To 5 Meters

Audio (One-Way)

Microphone Built-In Omni-Directional Microphone
Sensitivity -48db +/- 3db

Frequency 50~16000hz

Audio Codec PCM (Audio In)

Video

Compression MJIPEG

Auto Exposure Yes

Auto White Balance Yes

Auto Gain Control Yes

Resolution And Frame Rate

VGA (640 X480) @ 30 FPS
QVGA (320X 240) @ 30 FPS
QQVGA (160 X 120) @ 30 FPS

Networking

Network Protocols

IPV4, ARP, TCP/IP, UDP, ICMP, DHCP, NTP, DNS, DDNS, SMTP,
FTP, HTTP, PPPoE, UPnP and SSL, Bonjour

Ethernet |EEE 802.3u 10/100Mbps Auto-MDIX Fast Ethernet
Wireless |EEE 802.11 b/g/n Wireless LAN

Security 64/128-bit WEP, WPA / WPA2-PSK

Hardware

System ROM 4MByte NOR Flash

System RAM 32MByte SDRAM

Power LED Orange Color

Link/Act. LED Green Color

Reset Button Push And Hold Over 5 Sec Will Be Factory Reset
WPS Button Yes

RJ45 Port X1

Antenna Built-In 2.5dbi Internal Antenna

Power DC5V/1.2A

Power Consumption 3.5 Watts Max. 4.5 Watts Max.

Operation Temperature/Humidity

0°C ~ 45°C (32°F ~ 104°F)/20% ~ 85% (Non-Condensing)

Storage Temperature/Humidity

-15°C ~ 60°C (5°F ~ 140°F)/0% ~ 90%(Non-Condensing)

Approvals

FCCICE class B

Dimensions (Body Only)

2.9 (W) X 3.7" (H) X 1.2" (D) / 74mm (W) X 95mm (H) X 30.5mm (D)

Weight (Body Only)

0.19Ibs / 85g




1.4 System Requirement

] Networking

- LAN: 10Base-T Ethernet or 100Base-TX Fast Ethernet, Auto-MDIX
- WLAN: IEEE 802.11b/g/n
] Accessing the Camera using Web Browser
- Platform: Microsoft® Windows® 2000/XP/Vista/Win7
- CPU: Intel Pentium [l 800MHz or above
- RAM: 512MB
- Resolution: 800x600 or above

- User Interface: Microsoft® Internet Explorer 6.0 or above; Apple Safari 2 or above;
Mozilla Firefox 2.00 or above; Google Chrome

] Accessing the Camera using UltraView Pro

- Platform: Microsoft® Windows® XP/Vista/Win7
- Resolution: 1024x768 or above
] Hardware Requirement:
- 1~8 cameras: Intel Core 2 Duo 2GB RAM
- 9~32 cameras: Intel Core 2 Quad 4GB RAM

NOTE If you connect multiple cameras to monitor various places simultaneously, you are

recommended to use a computer with higher performance.



CHAPTER 2
Hardware Installation

2.1 Installing the Camera Stand
The camera comes with a camera stand, which uses a swivel ball screw head to lock to
the camera’s screw hole. When the camera stand is attached, you can place the

camera anywhere by mounting the camera through the three screw holes located in the
base of the camera stand.

The Camera Stand

10



2.2 Connecting the Camera to LAN/WLAN

Use the p your local area network (LAN).
When you connect provided Ethernet cable (
to connect the camera to the AC power 1“
adapter, the camera is powered on
automatically. You can verify the power
status from the Power LED on the front
panel of the camera.

Once connected, the Link LED starts
flashing green light and the camera is on
standby and ready for use now.

Connecting the Ethernet Cable

When the camera is powered on, the camera will automatically search any
access point with “default” SSID.

NOTE
(For wireless model) If the camera cannot to your wireless network, you need to install
the camera in LAN and proceed with WLAN settings.

11



2.3 Applications of the Camera

The camera can be applied in multiple applications, including:

B Monitor local and remote places and objects via Internet or Intranet.

B Capture still images and video clips remotely.

B Upload images or send email messages with the still images attached.

The following diagram explains one of the typical applications for your camera and
provides a basic example for installing the camera.

Home Applications

®
_\t/.//

*
Out Door

Baby Room Working Room

*Please enclosed by waterproof

housing when using in outdoor

12



Chapter 3
Software Installation

3.1 IPFinder

The camera comes with a conveniently utility, IPFinder, which is included in the
Installation CD-ROM, allowing you to search the camera on your network easily.

1. Insert the Installation CD-ROM into your computer’'s CD-ROM drive to initiate the
Auto-Run program.

2. Click the IPFinder item to launch the utility. The control panel will appear as below.

{ Q PFinder XA

Display the connected
camera(s)

Double click to link the
camera

I 192.168.0.30 IP Camera 00:FF:08:20:03:05 I

| About H Link H Change IP H Search H Exit ] k_l

Click About to get the Version information of IPFinder.

Click Link to connect the selected camera.

Click Change IP to modify the IP address of the selected camera.
Click Search to find the IP address of the connected camera(s).
Click Exit to close the utility.

3. Once you get the IP address of the camera, launch the Web browser or UltraView
Pro to access your camera.

13



3.2 Accessing to the Camera

Whenever you want to access the camera:

1. Since the default configuration of the camera is DHCP mode enabled, you are
recommended to launch IPFinder to search the IP address that is assigned to the
camera by the DHCP server, and then click Link to access the camera via the Web
browser.

2. If Network Camera can't get IP Address under DHCP mode, the default IP Address
will be 192.168.0.30.

3. When the login window appears, enter the default User name (admin) and
password (admin) and press OK to access to the main screen of the camera’s
Web Configuration.

£}

[ B b POsen Frrmoms @meia @) (3- 00 JE

& o800

Enter the User name
and Password.

NOTE If you are initially access to the camera, you will be ask to install a new plug-in for
the camera. Permission request depends on the Internet security settings of your
computer. Click Yes to proceed.

14



After you login into the Web Configuration of the camera, the main page will appear as
below:

il = 7 12168030 s v colpctien st 0 - B € X | 3 icess Nework omens <[
£ Zoom In Buttons

=i
Live View/Setup Switch &

W, ]
PRy
? %’

*("\ ¥ '

#ce' Internet Camera

he main page of the Web Configuration provides you with many useful information and

functions, including:

B Camera Information — Display the camera’s location and the current date & time.
The information can be modified in the Web Configuration.

B Language — Select your favorite displayed language for the system.

Live View Image — Displays the real-time image of the connected camera.

B Live View/Setup Switch — Click Setup to configure the camera. For details, see
Chapter 4 and Click the Live View button to return to the Main screen to view the
live view image.

B Function Buttons — Use these buttons to control the video functions.

® Manual Record allows you to record and save a video clip.

® Snapshot allows you to capture and save a still image.

® Browse allows assign the destination folder to store the video clips and still
images.

® Listen allows you to receive the on-site sound and voice from the camera.

15



B Zoom In Buttons — Click the buttons to zoom in the live view image by 1x, 2x, and

3X.

NOTE If your PC use Microsoft Vista platform, you may be unable to find these recorded
files what stored by Snapshot or Manual Record. You need to disable the
protected mode of Security in the IE Browser. Please follow as below Steps:

1.

2.
3.
4

Open |IE Browser

Select Tools-> Internet Options

Select Security

Disable the “Enable Protected Mode” then press OK

16



3.3 Configuring the IP Address of the PC

If you are failed to access to the camera, please check the IP address of your computer.
When you connect the camera to your computer directly to proceed with configuration of
the camera, you need to set up the IP addresses to be in the same segment for the two
devices to communicate.

1.
2.
3.

On your computer, click Start > Control Panel to open the Control Panel window.
Double-click Network Connection to open the Network Connection window.
Right-click Local Area Connection and then click Properties from the shortcut
menu.

When the Local Area Connection Properties window appears, select the General
tab.

Select Internet Protocol [TCP/IP] and then click Properties to bring up the
Internet Protocol [TCP/IP] Properties window.

To configure a fixed IP address that is within the segment of the camera, select the
Use the following IP address option. Then, enter an IP address into the empty
field. The suggested IP address is 192.168.0.x (x is 1~254 except 30), and the
suggested Subnet mask is 255.255.255.0.

When you are finished, click OK.

17



Chapter 4
Configuring the Camera

4.1 Web Configuration

You can access and manage the camera through the Web browser and the provided
software application UltraView Pro. This chapter describes the Web Configuration, and
guides you through the configuration of the camera by using the web browser.

To configure the camera, click Setup on the main page of Web Configuration. The Web
Configuration will start from the Basic page.

The Web Configuration contains the settings that are required for the camera in the left
menu bar, including Smart Wizard, Basic, Network, Video, Event Server, Motion
detect, Event Configuration, Tools, and Information.

18



4.2 Smart Wizard

The camera’s Smart Wizard lets you configure your camera easily and quickly. The

wizard will guide you through the necessary settings with detailed instructions on each

step.

To start the wizard, click Smart Wizard in the left menu bar.
Step 1. Camera Settings

Jcamera Settings

‘Camera Name: wireless network camera 1 Enter the name for
<4— |the camera and
-Location: classroom 1 place
-Admin Password: sssse Enter the
-Confirm Password: |eeeee adm|n|5trat0r
password.
Step 2. IP Settings
JiP settings Select the IP

- ® DHCP
- O staticIP
-IP
- Subnet Mask
- Default Gateway
« Primary DNS
- Secondary DNS
- O PPPOE
+ User Name

- Password

setting according
to your network:
DHCP, Static IP,
or PPPoE.

19



Step 3. Email Settings

JEmail Setting

- SMTP Server Address: mail com Enter the required

- Sender Email Address: mymail@mail.com information to be

- SMTP Port: 2% able to send email
[C]This server requires an encrypted connection (SSL) Wlth image'
[F1sTARTTLS

- Authentication Mode: @ None © sMTP

- Sender User Name: |
- Sender Password: |
- Receiver #1 Email Address:

« Receiver #2 Email Address:

o] [Gare

Step 4. Wireless Networking (for wireless model)

Jwireless Networking

- Network ID(SSID): default Site Survey

- Wireless Mode: @ Infrastructure O Ad-Hoc
- Channel: Complete the required
- Authentication: [Open  [v settings for wireless
networking.
+ Encryption @® None O WEP
« Format ASCIT' HEX
- Key Length 64 bits 128 bits
WEP Key 1
WEP Key 2
WEP Key 3
WEP Key 4

20



Step 5. Confirm Settings

|C0nﬁrm Settings

- Camera Name:

+ Location:

« IP Mode:

+ IPv4 Address:

+ Subnet Mask:

- Default Gateway:

« Primary DNS:

- Secondary DNS:

+ SMTP Server Address:
« SMTP Port:

- SSL:

+ STARTTLS:

+ Sender Email Address:
+ Authentication Mode:
+ Sender User Name:

- Receiver #1 Email Address:
+ Receiver #2 Email Address:
- ESSID

+ Connection:

+ Channel:

« Authentication:

- Encryption:

DHCP
192.168.0.30
255.255.255.0
192.168.0.1

mail.com

25

Disable

Disable
mymail@mail.com
None

default
Infrastructure
6

Open

None

This step shows the configuration of your camera. When you confirm the settings, click

Apply to finish the wizard and reboot the camera. Otherwise, click Prev to go back to
the previous step(s) and change the settings; or click Cancel to end the wizard and

discard the changes.

21



4.3 Basic Setup

The Basic menu contains three sub-menus that provide the system settings for the
camera, such as the Camera Name, Location, Date & Time, and User management.

Basic >> System
B Basic
- Camera Name: Enter a descriptive name for the camera.
- Location: Enter a descriptive name for the location used by the camera.
B Indication LED
This item allows you to set the LED illumination as desired. There are two options:
Normal and OFF.

Basic >> Date & Time
B Date & Time

- Time Zone: Select the proper time zone for the region from the pull-down menu.

- Synchronize with PC: Select this option and the date & time settings of the
camera will be synchronized with the connected computer.

- Synchronize with NTP Server: Select this option and the time will be
synchronized with the NTP Server. You need to enter the IP address of the
server and select the update interval in the following two boxes.

- Manual: Select this option to set the date and time manually.

22



& Wireless Network Camera

Fecw/ Internet Camera

Live V. < 2
BuLive View |Basic»Date & Time
B setwp » Date and Time

. TimeZone: (GMT)Greenwich Mean Time : Dublin, Edinburgh, Lisbon, London v

Smart Wizard [ Automatically adjust clock for daylight saving time changes

" D Synchronize vith PC
- Basic

» System Synchronize vith NTP Server

+ NTP Server Address: 0.pooLntp.org

» User + Update Interval: 6 ¥ hours

- Network ® Manual

- Video/Audio - Date: 1970/01/01  (YYYY/MM/DD)

- Event Server - Time: 00:54:28 (hh:mm:ss)

- Motion Detect

- Event Config

| i

- Information

Basic >> User
B Administrator
To prevent unauthorized access to the camera’s Web Configuration, you are
strongly recommend to change the default administrator password. Type the
administrator password twice to set and confirm the password.
B General User
- User Name: Enter the user's name you want to add to use the camera.
- Password: Enter the password for the new user.
When you are finished, click Add/Modify to add the new user to the camera. To
modify the user’s information, select the one you want to modify from UserList and
click Add/Modify.
- UserList: Display the existing users of the camera. To delete a user, select the
one you want to delete and click Delete.
B Guest
- User Name: Enter the guest’'s name you want to add to use the camera.
- Password: Enter the password for the new guest.

23



- UserList: Display the existing guests of the camera. To delete a user, select the
one you want to delete and click Delete.

NOTE The “General User” can access the camera and control the Function buttons of
the camera’s Web Configuration; the “Guest’ can only view the live view image
from the main page of the Web Configuration while accessing the camera. Only
the “Administrator” is allowed to configure the camera through the Web
Configuration.

Bl © nitp://192.168.0.30/admin/setup.coitpage=usen © = B & X | @ Wireless Network Camera [l

Internet Camera

Live View =
B‘ IBaslc"User
B setup » Administrator
- Password:

Smart Wizard + Confirm Passvord:

» General User

+ User Nama:
RN + Password:
< Viao Ko - Usertist: -
- Event Server
- Motion Detect P
- Event Config PR AddModity
- Tools - Password:
- Information B -

24



4.4 Network Settings

The Network menu contains three sub-menus that provide the network settings for the
camera, such as the IP Setting, DDNS Setting, IP Filter, and Wireless (for wireless
model).

S Vireesc Network Camera

dynecom v

nHTTPS

Network >> Network

B |P Setting
This item allows you to select the IP address mode and set up the related
configuration.

- DHCP: Select this option when your network uses the DHCP server. When the
camera starts up, it will be assigned an IP address from the DHCP server
automatically.

- Static IP: Select this option to assign the IP address for the camera directly.
You can use IPFinder to obtain the related setting values.

25



IP

Enter the IP address of the camera. The default
setting is 192.168.0.30.

Subnet Mask

Enter the Subnet Mask of the camera. The default
setting is 255.255.255.0.

Default Gateway

Enter the Default Gateway of the camera. The
default setting is 192.168.0.1.

Primary/
Secondary DNS

DNS (Domain Name System) translates domain
names into IP addresses. Enter the Primary DNS
and Secondary DNS that are provided by ISP.

- PPPOE: Select this option when you use a direct connection via the ADSL
modem. You should have a PPPoE account from your Internet service provider.

Enter the User Name and Password. The camera will get an IP address from
the ISP as starting up.

NOTE Once the camera get an IP address from the ISP as starting up, it automatically

sends a notification email to you. Therefore, when you select PPPoE as your

connecting type, you have to set up the email or DDNS configuration in advance.

B DDNS Setting

With the Dynamic DNS feature, you can assign a fixed host and domain name to a
dynamic Internet IP address. Select the Enable option to enable this feature. Then,
select the Provider from the pull-down list and enter the required information in the

Host Name, User Name, and Password boxes. Please note that you have to sign up
for DDNS service with the service provider first.

H  UPnP

The camera supports UPnP (Universal Plug and Play), which is a set of computer
network protocols that enable the device-to-device interoperability. In addition, it

supports port auto mapping function so that you can access the camera if it is behind
an NAT router or firewall. Select the Enable option to enable this feature.

B Ports Number

- HTTP Port: The default HTTP port is 80.

NOTE If the camera is behind an NAT router of firewall, the suggested to be used is

from 1024 to 65535.

26



HTTPS

- Enable: Select this option to enable HTTPS, which is a secure protocol to
provide authenticated and encrypted communication within your network.

- HTTPS Port: Assign a HTTPS port in the text box. The default HTTPS port is
443.

Network >> IP Filter

The IP Filter setting allows the administrator of the camera to limit the users within a
certain range of IP addresses to access the camera. To disable this feature, select the
Disable option; otherwise, select the Accept option to assign the range of IP addresses
that are allowed to access the camera, or select the Deny option to assign the range of
IP addresses that are blocked to access the camera.

Disable: Select this option to disable the IP Filter function of the camera.
Accept
- IPv4: Assign a range of IP addresses that are allowed to access the camera by
entering the Start IP address and End IP address options. When you are
finished, click Add to save the range setting. You can repeat the action to assign
multiple ranges for the camera.
IPv6: Enter the IP Address that is allowed to access the camera.
Deny
IPv4: Assign a range of IP addresses that are blocked to access the camera by
entering the Start IP address and End IP address options. When you are
finished, click Add to save the range setting. You can repeat the action to assign
multiple ranges for the camera.
IPv6: Enter the IP Address that is not allowed to access the camera.

For example, when you enter 192.168.0.50/192.168.0.80 in Start/End IP Address of
Accept > IPv4, the user whose IP address located within 192.168.0.50 ~ 192.168.0.80
will be allowed to access the camera. On the other hand, if you enter the IP range in
Start/End IP Address of Deny > IPv4, the user whose IP address located within the
range will not be allowed to access the camera.

Network >> Wireless Setting (for wireless model)

27



The camera supports WLAN while you use the wireless network. Select the Enable
option to enable this feature.

@ Wireless Network Camera %

Feww/ Internet Camera

BhiLive View Inetwork» Wireless Setting
B setup » Wireless
Enable
Smart Wizard « Network ID(SSID): defautt
- Basic * Wireless Mode: ® Infrastructure © Ad-Hoc
o + Channel:
, - Authentication: Open -
@_ + Encryption: ® None ® WEP
» wes - Format: 3 ASCII HEX
- Video/Audio + Key Length: © 64 bits 128 bits
- EventServer ® WEP Key 1
- Motion Detect WEP Key 2
- Event Config WEP Key 3
- Tools WEP Key 4

- Information

B Wireless

- Network ID (SSID}: Keep the default setting of this option to connect the
camera to any access point under the infrastructure network mode. To connect
the camera to a specified access point, set a SSID for the camera to correspond
with the access point's ESS-ID. To connect the camera to an Ad-Hoc wireless
workgroup, set the same wireless channel and SSID to match with the
computer’s configuration.

Click Site Survey to display the available wireless networks, so that you can easily

connect to one of the listed wireless networks.

28



l'\elwork Wireless Setting

1(SSIC corega Site Survey |

List of searching results

- Wireless Mode: Select the type of wireless communication for the camera:
Infrastructure or Ad-Hoc.

- Channel: Select the appropriate channel from the list.

- Authentication: Select the authentication method to secure the camera from being
used by unauthorized user: Open, Shared-key, WPA-PSK, and WPA2-PSK. The
following table explains the four options:

Open The default setting of Authentication mode, which

communicates the key across the network.

Shared-key Allow communication only with other devices with

identical WEP settings.

WPA-PSK/ WPA-PSK/WPA2-PSK is specially designed for the

WPA2-PSK users who do not have access to network

authentication servers. The user has to manually enter

the starting password in their access point or gateway,

as well as in each PC on the wireless network.

If you select Open or Shared-key as the Authentication mode, you need to

complete the following settings:

Encryption: Select the WEP option to enable the data encryption feature to
secure the camera within the wireless network.

Format: Once you enable the Encryption feature, you need to determine the
encryption format by selecting ASCII or HEX. ASCII format causes each
character you type to be interpreted as an eight-bit value. Hex format causes
each pair of characters you type to be interpreted as an eight-bit value in
hexadecimal (base 16) notation.

29



Key Length: Select the WEP key length you use: 64 bits or 128 bits.
WEP Key 1/2/3/4: Enter the WEP key(s) in the following boxes.
If you select WPA-PSK or WPA2-PSK as the Authentication mode, you need to
complete the following settings:
Encryption: Select TKIP or AES. TKIP (Temporal Key Integrity Protocol)
changes the temporal key every 10,000 packets to insure much greater security
than the standard WEP security. AES (Advanced Encryption Standard) is used to
ensure the highest degree of security and authenticity for digital information.
Pre-Shared Key: This is used to identify each other in the network. Enter the
name in the box, and this name must match the Pre-shared key value in the
remote device.
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Network >> Wireless >> WPS Setting (for wireless model)
WPS (Wi-Fi Protected Setup) sets a new standard of Wi-Fi security, providing a

simplified secure network setup solution for the end users. WPS can be enabled by the
following two options:
1. PIN Mode

2. PBC Mode (or WPS button on the device, depending on hardware design)

PR’ Internet Camera

B Live View INelwork"WireIess »WPS Setting
© Setup »wps

@ PIN Mode:

Smart Wizard + PIN Code:

10884994
e PBC Mode:
- Network

» Device Status

- Video/Audio

Device Idle

- EventServer
- Motion Detect
- Event Config
- Tools

- Information

B PROTECTED SETUP
Press the Reset to Unconfigured button to reset the WPS configuration of the
camera.

m  WPS

- PIN Mode: The PIN (Personal Information Number) mode builds the connection
by entering the PIN Code directly.
a. Click the PIN Mode option.
b. Click Site Survey button to select the router (or access point) you want to
connect.
c. Click the Connect button to start WPS function of the camera.

You need to enter the PIN Code displayed on the camera to the router (or
access point) within 120 seconds to complete the setup.
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- PBC Mode: The PBC (Push-Button-Configuration) mode builds the connection
by simply pressing a button on the device.
a. Click the PBC Mode option.
b. Click the Connect button to start WPS function of the camera.

TIP Instead of clicking the Connect button of Configuration Utility, you can press
the WPS button if the camera is designed with a hardware button of WPS
function.

c. You need to press the WPS button on the router (or access point) within
120 seconds to complete the setup.
B Device Status
Display the WPS configuration of the camera.

TIP The Power LED indicates the WPS connection status by:

- blinking 3 times when the connection is built successfully.
- repeating 3 times of short-short-long blink when the connection is failed.
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4.5 Setting up Video & Audio

The Video & Audio menu contains four sub-menus that provide the video and audio
settings for the camera.

B‘Lwe View

Qsetup

Smart Wizard

- Basic
- Network

- Video/Audio

- Event Server

- Motion Detect

» Image Setting

- Event Config - Brightness: 50 (0~100)
- Tools - Contrast: 50  (o~100)
- Information - Saturation: 2 (o~100)(Defaut |
+ Mirror: [ vertical [0 Horizontal
- Light Frequency: © s50Hz @ 60Hz @ Outdoor

» Overlay Setting

+ [ Include Date & Time

Aoply

Video & Audio >> Camera
B Image Setting
- Brightness: Adjust the brightness level from 0 ~ 100.
- Contrast: Adjust the contrast level from 0 ~ 100.
- Saturation: Adjust the colors level from 0 ~ 100.
TIP  Click Default then Apply to restore the default settings of the three options
above.
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- Mirror: Select the Horizontal option to mirror the image horizontally. Select the
Vertical option to mirror the image vertically.

- Light Frequency: Select the proper frequency according to the camera’s
location: 50Hz or 60Hz.

Video & Audio >> Video
B MJIPEG
- Video Resolution: Select the desired video resolution from the three formats:
VGA, QVGA and QQVGA. The higher setting (VGA) obtains better video quality
while it uses more resource within your network.

- Video Quality: Select the desired image quality from five levels: Lowest, Low,
Normal, High, and Highest.

- Frame Rate: Select a proper setting depending on your network status. The
available setting value includes: 5, 10, 15, 20, or 25.

Video & Audio >> Audio
B Camera Microphone In:
- Enable: Select the Enable option to enable the camera's audio function, so that
you can receive the on-site sound and voice from the camera.
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4.6 Event Server Configuration

The Event Server menu contains two sub-menus that allow you to upload images to

FTP, and send emails that include still images.
When you complete the required settings for FTP, or Email, click Test to test the related

configuration is correct or not. Once the camera connects to the server successfully,

click Apply.

Event Server Setting>> FTP
FTP

Host Address: Enter the IP address of the target FTP server.

Port Number: Enter the port number used for the FTP server.

User Name: Enter the user name to login into the FTP server.

Password: Enter the password to login into the FTP server.

Directory Path: Enter the destination folder for uploading the images. For
example, /Test/.

Passive Mode: Select the Enable option to enable passive mode.

€ Gl @ hitp://192.168.0.30/admin/setup.caitpage=Ttp& O ~ B & X | @ wireless Network Camera

PR’ Internet Camera

B Live View IEvent Server Setting” FTP
@ setup »Fre
+ Host Address:
Smart Wizard + Port Number: 21

+ User Name:

- Basic

- Passvord:

- Network

+ Directory Path:

- Video/Audio

- Passive Mode: @ enable

- Event Server

> Emed Test Cancel

- Motion Detect

- Event Config

- Tools

- Information
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Event Server Setting >> Email

®  Email
- SMTP Server Address: Enter the mail server address. For example, mymail.com.
- Sender Email Address: Enter the email address of the user who will send the

email. For example, John@mymail.com.

SMTP Port: Assign the SMTP port in the text box. The default SMTP port is 25. If

the mail server requires an encrypted connection, you should check the SSL

option. STARTTTLS is an extension to plain text communication protocols. It

offers a way to upgrade a plain text connection to an encrypted (TLS or SSL)

connection instead of using a separate port for encrypted communication.

- Authentication Mode: Select None or SMTP according to the mail server
configuration.

- Sender User Name: Enter the user name to login the mail server.

- Sender Password: Enter the password to login the mail server.

- Receiver #1 Email Address: Enter the first email address of the user who will
receive the email.

- Receiver #2 Email Address: Enter the second email address of the user who
will receive the email.

- WAN IP Change Notification: Select the option to enable the system to notify
you when the WAN IP address changed.

i Internet Camera

Baiivs View IEven( Server Setting” Email

B setup » Email

+ SMTP Server Address:

Smart Wizard + Sender Email Address:
+ SMTP Port: 2
- Basic
[E] This serv ires an encrypted connection (SSL)

- Network
ElstarTTLS
- Video/Audio
+ Authentication Mode: @ None® SMTP
- Event Server

+ Sender User Name:
+ Sender Password:
- Motion Detect + Receiver #1 Email Address:

¥ Event Config + Receiver #2 Email Address

- Tools [Jwan 1P Change Notify

- Information

e


mailto:John@mymail.com

4.7 Motion Detect

The Motion Detect menu contains the command and option that allow you to enable and
set up the motion detection feature of the camera. The camera provides two detecting
areas.

To enable the detecting area, select Window 1 or 2 from the pull-down list, and then

select Enable. When the detecting area is enabled, you can use the mouse to move the
detecting area and change the area coverage.

lMotion Detection »Detection Configuration

Motion Detect

Window: [1 ¥

v Enable
Hone

Threshold:

Sensivty:

Save Cancel

- Name: Assign a name to the detecting area.

- Threshold: Move the slide bar to adjust the level for detecting motion to record
video.
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4.8 Event Configuration

The Event Configuration menu contains four sub-menus that provide the commands to
configure event profiles.

Event Configuration >> General Setting
- Snapshot/Recording Subfolder: You can assign a given sub-folder for
captured file. Otherwise, leave this option blank to use the default setting.

http://192.168,0.30/admin/setup.coitpage=gene O ~ B & X | @ Wireless Network Camera

B Live View
B setup » General

- Snapshot Subfolder:

IEvent Configuration» General Setting

Smart Wizard

- Basic

- Network

- Video/Audio
- Event Server
- Motion Detect

- Event Config

- Tools

- Information

Event Configuration >> Arrange Schedule Profile

This sub-menu displays the scheduled profile(s). To customize the profile, click Add
and then enter a descriptive name for the profile in the prompt dialog window. After
entering the profile name, click OK and the profile is added to the Schedule Profiles list.
To delete the profile, select the profile in the list and click Delete.
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Profile Name: Display the profile name that you select in the Schedule Profiles
list.

Weekdays: Select the weekday(s) that you want to separately assign in the
schedule profile. The weekday that has been assigned will be displayed with
green color.

Time List: Display the time period that you have assigned within the selected
weekday. To assign the same time period to every weekday, click Add this to
all weekdays; click Delete this from all weekdays to remove the selected time
period from every weekday. Click Delete to remove the selected time period.
Start/End Time: Enter the start and end time and then click Add to assign a
time period within in the selected weekday.

Event Configuration >> Motion Detect Trigger

Select the Enable option to enable the trigger function of the camera, so that you can
send captured images within the detecting area to the FTP server, or email receiver.
You have to configure corresponding settings, such as FTP server and email server, to
enable this feature.

Schedule Profile: Select a schedule profile from the pull-down list.
Action: Select the destination that the captured images will be sent to: Send
Email, or FTP Upload.

BhiLive View IEvent Configuration” Motion Detect Trigger
B setup » Motion Detect Trigger (*Please set the corresponding server setting first)
[ enable
Smart Wizard + Schedule Profile: always v

Y + Action: [ send Email

i B FTP Upload

- Video/ Audio

- Event Server

- Motion Detect

- Event Config

- Tools

- Information
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Event Configuration >> Schedule Trigger

You can separately configure the schedule for trigger function of the camera by Email,

or FTP. Select the Enable option on each item, and then select a Schedule Profile
from the pull-down list and set the Interval time.

Live View = %
L] IEvent Configuration» Schedule Trigger
B setup » Email Schedule
[ enable
Smart Wizard - Schedule Profile: always v
. - Interval: 20 sec(s)
- Basic
- Network
» FTP Schedule
- Video/Audio
[0 enable
- Event Server
+ Schedule Profile: always v
- Motion Detect
- Interval: 30 sec(s)
- Eventcanﬁg

PTEE——
- Tools

Apply

- Information
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4.9 Tools

The Tools menu provides the commands that allow you to restart or reset the camera.
You can also backup and restore your configuration, and upgrade the firmware for the
camera.

less Network Camera X

i Live View Isystem Tools» Tools
© Setup » Factory Reset
+ Factory reset vill restore all the setting
Smart Wizard
» System Reboot
- Basic
+ System vill be rebooted
- Network
- Video/Audio
» Configuration
- Event Server [ —
& backup.
- Motion Detect #Backup
- Event Config + Restore: Browse...
= Tools
= Informatica » Update Firmware
+ Current Firmware Version: 1.0.0 build:1
. Selact the firmware: Update

Factory Reset
Click Reset to restore all factory default settings for the camera.

System Reboot
Click Reboot to restart the camera just like turning the device off and on. The
camera configuration will be retained after rebooting.

Configuration
You can save your camera configuration as a backup file on your computer.
Whenever you want to resume the original settings, you can restore them by
retrieving the backup file.
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- Backup: Click Get the backup file to save the current configuration of the
camera.
- Restore: Click Browse to locate the backup file and then click Restore.
B Update Firmware
This item displays the current firmware version. You can upgrade the firmware for
your camera once you obtained a latest version of firmware.
- Select the firmware: Click Browse to locate the backup file and then click
Update.

NOTE Make sure to keep the camera connected to the power source during the
process of upgrading firmware. Otherwise, the camera might be damaged
because of failure of upgrading firmware.
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4.10 Information

The Information menu displays the current configuration and events log of the camera.

CIE) /7192168030 admin/setup.caitpage=devii © ~ B & X | ¢

- Tools

- Information

et Internet Camera

8. Live View.
@ setwp » Basic

+ Camera Name:

+ Location:
Smart Wizard
- Firmvare Version:

- Basic
» Video & Audio

= etwirk - MIPEG Resolution:

- Video/Audio - Microphone In:

- Event Server
» Network

- Motion Detect G

- Event Config - IPv4 Address:

+ 1Pv4 Subnet Mask:

- 1Pv4 Gatevay:

+ Primary DNS Address:
- Secondary DNS address:
- 1Pv6 Address:

« IPv6 Gatevay:

- MAC Address:

+ UPnP Enable:

- Bonjour:

« HTTP Port:

- Wan IP:

» Wireless
- ESSID:
- Connection:
+ Channel:
-+ Authentication:
« Encryption:

Device Info
Display the Basic, Video, Network, and Wireless settings (for wireless model) of the
camera.

System Log
The Logs table displays the events log recorded by the system.

Wireless Network Camera

ISvstem Information» Device Information

Rosevill
Office
1.0.0 build: 1

VGA
Enable

DHCP
152.168.0.20
255.255.255.0
192.168.0.1

fe80::21a:97ff:fe01:80c3
N/A

00:13:97:01:80:c3
Enable

Enable

80

0.0.0.0

default
Infrastructure
Not Connected
Open

None
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CHAPTER 5
Software Application - UltraView Pro

5.1 Introduction

This Software User Guide provides detailed instructions on operating UltraView Pro, a
customized software application with a user-friendly interface allowing you to access
and control your camera(s). You can connect up to 32 cameras to monitor different
places and record events for each camera. With UltraView Pro, you can also change
some basic settings of the camera, such as schedule profiles and motion detecting. In
addition, if your camera supports advanced features, such as audio or pan/tilt function,
you can use these functions through the control panels of UltraView Pro.
To use UltraView Pro, you have to install it in your computer. It is recommended to use a
high performance computer if you want to connect multiple cameras simultaneously.

Platform: Microsoft® Windows® XP/Vista*, and Windows 7

Hard Disk: 80GB or above

Resolution: 1024x768 or above

Hardware Requirement
1~8 cameras: Intel Core 2 Duo; 2GB RAM
9~32 cameras: Intel Core 2 Quad; 4GB RAM
* For Windows Vista users: please go to User Accounts and Family Safety > User
Accounts > Turn User Account Control on or off, then uncheck the “Use User Account
Control (UAC) to help protect your computer checkbox. Restart your computer to
validate the setting. For additional information of User Account Control, please go to
http://www.microsoft.com/windows/products/windowsvista/features/details/useraccount
control.mspx

44



5.2 Installation

IMPORTANT! Before installing the program, make sure that the Avira AntiVir (the
anti-virus application) is not installed in your computer system.
Otherwise, UltraView Pro might be malfunctioned while operating in
your system.
1. Insert the Installation CD-ROM into the CD drive of your computer to initiate the
Auto-Run program.
The Auto-Run screen provides the following buttons:
- Quick Guide
- Advanced Guide
- Software Manual
- IPFinder
- Install Software
- Browse
- Exit
2. Click Install Software, and the setup wizard appears to help you complete the
installation step-by-step.

NOTE To use UltraView Pro, you must have Microsoft .NET Framework 2.0
installed in the computer. The setup wizard will detect it and, if the program
is not installed yet, ask you to install it during the process of installing
UltraView Pro.

Microsoft Windows Installer 3.0 or above is a required component to install
UltraView Pro. For more information of the required component during
installation, please visit the Microsoft support Website.
3. Click Install. The Install Shield Wizard starts to install UltraView Pro to your
computer.
The Status bar indicates the installation process.
4. When done, click Finish to complete the installation.
You will see the program icon appeared on the desktop of your computer.
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F ‘
N
TltraView Pro

TIP  The IPFinder program will be installed in your computer simultaneously when you
install UltraView Pro.

¥ ‘
(2.8
[FFinder
For more information of using IPFinder, refer to Chapter 5 or the User Guide provided

by your camera.
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5.3 Using UltraView Pro
5.3.1 Starting the Program

1. Click Start = Programs = UltraView Pro = UltraView Pro.
Alternatively, you can start the program by double-clicking the program icon on the
desktop of your computer.

2. On the login window, enter the User name/Password and click OK to login.
If this is the first time you start the program and login, use the default User name /
Password: admin / admin.

The Best SMB' & Chain Store Security Solution

Please enter user name and passwaord

NOTE For security purpose, you are highly recommended to change the default user
name and password after login. For more information, see the Configuring the
System > User Management section.

47



5.3.2 Main Window and Item Feature

When you start and login to UltraView Pro, the Main window will display as below:

V

troView

20101114
153045

The Main window provides you with the information on operating the system, as well as

the control panel such as the Quick Launch buttons, and so on.

NOTE UltraView Pro requires the resolution setting up to 1024 x 768. For best view of
the application, you are recommended to configure the resolution setting to
1024 x 768 or higher; otherwise, it cannot be displayed on the screen when
launching the program.
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O Live View Window displays the live video of the connected camera(s).

® Quick Launch Buttons are located below the Live View Window, providing you with
uick-launch functions:

the following q

Button

Function

Click to select Logout or Close UltraView Pro.

Click to select Restore Recording Type, All Continuous
Recording, or Stop All Recording.

Click and then select to display the View Setting window, switch
to the eMap View window, or check the Camera Status.

Click to display the Playback window.

Click to display the Schedule Configuration window.

Click to configure the event settings: Event Server, Address
Book, and Event Trigger.

Click to configure Device Setting and Recording Setting.

@EREYE @ e

Click to set the Account, Language, and System Setting; or
view the Version or the program.

® Camera View Mode buttons in this area allow you to switch the camera view mode.

Function

Display the connected camera(s) in single camera view mode.

Display the connected camera(s) in quad view mode.

Display the connected camera(s) in 3 x 3 grid view mode.

Display the connected camera(s) in 13-camera view mode using
a split window. The first camera is displayed as the major view.

B EBEEO

Display the connected camera(s) in 17-camera view mode using

a split window. The first camera is displayed as the major view.
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Display the connected camera(s) in N x N grid view mode,

supporting up to 32 cameras.

Display the live view of the selected camera in full screen mode.
Press the ESC key on the PC keyboard to resume the Main

window.

Automatically switch the live view of each connected cameras in
single camera view mode by 30 seconds*. Click once to start
and click again to stop.

@ * The auto-switch time is set as 30 seconds by default, which
can be changed by clicking the @ - System Setting and
then change the value from the pull-down list of the Auto
Switch time interval option.

® System Information displays the system information, including the date and time,
and the available storage space of the system.
© Live View Status provides the status of live view mode, including Camera List and
eMap.
® Camera List displays the status of the connected cameras. If multiple
cameras are connected, you can switch to the live view of each camera by
simply selecting the camera from the list.
® eMap allows you to select the desired camera to the view from the map easily.
Please note that you have to set up the eMap for monitoring in advance.
® Camera Control Buttons provides the control buttons that allow you to control the

selected camera.

Button Function

Talk On/Off. Click to enable/disable the speaker function of
the connected camera. This option is available only in single

camera view mode.

Listen On/Off. Click to enable/disable the microphone
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function of the connected camera. This option is available only

in single camera view mode.

If the connected camera features pan/tilt functions, you can
use this control panel to set the preset positions (up to 8
positions). Once configured, you can move the camera lens to
the desired position quickly.

To set the preset positions, adjust the camera lens to the
desired position using the Navigation buttons, and then select
the position number (1~8) from the Set button.

To move to the preset position, simply select the position

number (1~8) from the Go button.

Navigation Buttons (Left/Right/Up/Down/Home). If the
connected camera features panttilt functions, the Navigation
buttons allow you to move the camera lens position. Clicking
the Home (center) button will move the camera lens to the

assigned home position.

= 2

The Patrol/Stop buttons are used to enable/disable the
swinging function of the camera. Click Patrol to start patrolling
through the preset positions once. Click Stop to stop

patrolling.
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5.3.3 Accessing the Camera
Before you can access the camera, you have to add the camera to the system.

B Adding a Camera
B
1. Click the &) button and select Device Setting to display the Device Setting

window.
—

raView
PRO_

‘5 Device Settng
Device > Device Sefting

Davice List

Camera Title 1P address. Pon | CH# Brand Model Record Type Stream

3. Click Device Search to search the camera(s) within your network.



= Device Setting

=
Derice > New C .N
S

Proview |

Disconnect

Back fo List

Click Search to find the IP address of the connected camera(s). When search is
finished, select the camera and click Add.

Device Search

Device Search

IP address Port Device Hame WAC Address
(152,166,030 60

00:1A:97:00:01:53 l

Add Search Close
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5. The information of the camera will be displayed on the window.

(%]

ancel

Back 10 List

Option Description

Camera Title You have to assign a descriptive name for the camera.

IP Address Display the IP address of the camera.

Port Display the port path of the camera.

Account Display the user name for accessing the camera.

Password The password for accessing the camera will not be
displayed.

Stream Select the stream type as MPEG4, MJPEG, or H.264.

Record Select Yes or No to set up recording function of the
camera.

Preview This window allows you to preview the image of the

Window camera.

NOTE You MUST click Preview to display the image
before clicking Motion detection area and Save
to complete the camera installation; click
Disconnect to stop previewing.

6. When done, click Save and then click OK to return to the Device Setting window.

The added camera will be displayed in the Device List.
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7. Click the “X” button on the Device Setting window to return to the Main window. The

image of the camera will be displayed.

Tiie P sdiress Pot ce Brang Record Tyee Ssam
B Ca# 61680 3 2 7 o ot Rezord g WPEG
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B Editing / Deleting a Camera

Since you have added camera(s) to the system, you can select one to edit or remove.
o~

Click the &) button and select Device Setting to display the Device Setting window.

1. On the Device Setting window, the connected camera(s) will be displayed in the

Device List.

57 Doves it (x]

Deica > Detica Satting

Camera Tl 1P atress Por o Brand Record Type. Stream
P CAMAL 505 @ T Ganerc ot Recordng WPEGE

2. To delete the camera: select the desired one and then click Remove. When
prompted, click Yes and then select OK to confirm deletion.
To change the configuration of the camera: select the desired one and then
click Modify. The Modify Camera window will appear that allows you to change the
configuration of the camera. When completed, click Preview to display the image

before clicking Save and then click OK to return to the Device Setting window.

j odify ] [Remove ]

B Viewing Image of the Camera

56



Since you have added camera(s) to the system, the image of the selected camera(s)
will be displayed on the Live View Window automatically. You can view a maximum of
32 cameras simultaneously. Additionally, you can select one-camera or other view
mode to display the video from the Camera View Mode buttons.

For example, if you use only one camera, select single camera view mode ( D ), and
the Live View Window will display the view as below. You can select the other modes
according to your need.

The Information icon ( n ) on the top-right corner of the window provides you with
the options to connect/disconnect the camera, select a camera to be displayed in the
window, capture a still image of the camera live video, or switch to eMap mode. Click
the Information icon to pop up the shortcut menu and select the desired option.

Connect
Disconnect

Show Camera >
Snapshot

eMap
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5.3.4 Recording / Playing Video

You have to assign the target folder for saving the recorded files before recording.
B Configuring the Recording Settings

—
1. Click the button and then select Record Setting.

’ Device Setting

2. To assign the target folder for saving the recorded files, click the Browse button
next to the Recording Path option, and then select the desired directory.

To change the time of recording, select the desired time setting from the Record
File pull-down menu.

When completed, click Save

[0 Rovoct Soing

Device > Record Satting

Basic

d

ocord i 0 Saoonas

* Please choose the recording target older
For example

Ifthe Recarding Path is D:Wideo

“The network camera's recording fles wil be saved to D:WideoWideo Data\CHI

The etk ¢ g fies will be saved to D:\VidealVideo Data\CHA2
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B Enabling / Disabling Recording

While you are adding/editing the camera, you can enable the recording function for the

camera by selecting the Record option.

[ Dovioe Seting

Davice > New Camera

Setting

New Camera

Camera Title:
P adsess

Port
Account:

Password

Device Search

1P CAM #]
192166030
G

admin

Motion detection area

Preview Window

Stream: © MPEGI O MJPEG  H250

Record © No ) Yes

o) [omn ) oot

Alternately, you can set all cameras to start/stop recording when you connect multiple
cameras. Click the button and select All Continuous Recording to set all
cameras to start recording, or select Stop All Recording to set all cameras to stop
recording.

Since you have enabled the recording function of the camera, it will automatically start
recording and save the video clips. The recording time of each file is set to 60 seconds
by default.
NOTE The system will automatically delete the oldest files when storage space is
running out.
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B Setting up Schedule for Recording

The system features the schedule recording so that you can set up the schedule to
record as you need.

Click the button to display the Schedule Configuration window, which allows you

to configure the recording schedule.

92 Schedule Configuston <]

Schedule > Schedule Configuration

(Seheiis
Schedul List

Schedhe Title Sun | Mon  Tue  Wed Thu | Fn | Sa

Weekly Schedue

Schedule Tite: Select All_| [ Delete Al

001 2 3 4 55 7 8 910 1112 1314 1516 1718 1920 2122 23 2

ne sheckoncrmesns g r 0 minas, © Cick O Side =0 G
o 3051 600,05 o108

Click New, and then enter the Schedule Title.

2. Select the checkboxes below the Schedule Title to set the time to record video.
One checkbox stands for 30 minutes of recording time. You can choose to assign
the single checkbox repeatedly by using Click, or assign a period of time by using
Slide. Alternately, you can quickly select/cancel the checkboxes by clicking Select
All or Delete All.

3. When completed, click Save. The schedule profile will be added to the Schedule
List.

4. To edit the schedule, select the desired schedule profile from the list, and then

change the settings by using the Modify or Remove button.
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B Playback the Recording Files
1. Clickthe m button to display the Playback window.

UltraView
~—PRO.

PRO.

2. On the Playback window, set the conditions for search, such as selecting the
camera and setting the begin/end date and begin/end time. When the search

condition has been set, click Search.

T =l
Playback S

- “ Please dowrlosd the MPEGA codec. €€ s ot yet installed on your system. Dowrinad codsc

Single Cranel

sarch

amees BegnOwe [poning W BeonTme  [jigrzz 5
LA BNSIN0 ) ¥ enose  [monne ¥ EndTme: (2072 %
Search
Recont File Playback

-

Py | Stop Ourlosd




The search result will be displayed in the Record File list.

3. To playback the video clip, select the desired file and click Play.
i ]

Playback
* Ploase dowrlosd the MPEGH cadec, ift 5 not yat instatisd on your system

| I e S R e KT TE N |

Play Stop. Download

NOTE Codec is required for the system to play the video files. If the video clips cannot

be displayed in the Playback window normally, click link on the screen.
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5.4 Configuring UltraView Pro

5.4.1 Configuring the eMap View Setting

Click the button and select View Setting to configure the camera view setting of

eMap mode.

ehap View

| Camera Status

eMap refers to the geography and device scope of the UltraView Pro, which visually
presents the devices in your security system. It uses a background of the area (e.g. a
picture or a map) as the interface for monitoring.

1. On the View Setting window, click New.

o View Seting [X]
View > View Setting

o

Browsa.
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2. Enter the eMap Name.

(T VevS =}
View > View Seting
[owap |
aMap Lis
eMap Name image

eMiap Information
eMap Name: Previen
Gate #1

Image File:

3. Click Browse to select a Picture File from your computer. The selected picture will
be displayed in the Preview window.

o Veveeg =
Visw > View ating

eMap

shlap st
ahisp Namg Image

(]
Moty
Rermae

bap Informastion

elap Name
Gate 1

s e

When completed, click Save.

64



P Seing.

On the following window, you can assign the camera position in the eMap.

Click the Camera Location button to display the Edit window. Select the camera
from the Camera List, and then click the mouse on the desired position of the map.
The camera icon will be displayed on selected position of the map.

Vi > View
eMap

anap L

ohisp Harme. |llliiw

eMap Information
ahtap Hsene: Preaes
Gte 8

Image

=]
Sarting

File:

A O Vo i o

Camera List

w2

map to place the camera,

0 E=m

* Solect a camera fiom th camera s and then click
* Click on the camera icon on the mag to remave t ¥om the map.

on the map to p
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5. When completed, click Save.

48 0 Vg vl ' gt ]
Camera List MAP Nams
©@2

* Seect 3 cames o the camers st andthencick o the desed g postionc the s 0 plce the camer.
* Cck onhe camersicon o the map 1ot o he map
T Bk

6. To view from eMap:
a. Click the @ button and select eMap View.

View Setting

ehfap View

b. Select the map from the eMap Name list.

UltraView
~"PRO_ -

=

e
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C.

Click the camera icon, the camera window will then pop up to display the
on-the-spot image.

=PRO_—

| UltraView

Editing / Deleting the eMap

Click the L_, button and select View Setting.

To edit the eMap: In the eMap List, select the desired map and click Modify.
The map’s information will be displayed, where you can change the map’s

information and then click Save when completed.

To delete the eMap: In the eMap List, select the desired one and click Remove.

The selected map will be removed from the list.
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5.4.2 Configuring the System

B User Management
Click the @ button and select Account to change the administrator password for the

system.

Language

Version

System Setting

Enter the Current password, and then enter the new password twice (in the Type new

password and Retype password boxes). When completed, click Save.

[0 Becout Setting. ||

System > Account Sefting

[Edminisirator|

Cunent password
Type naw paseward.
Retype password

Email

E

Cancel
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5.4.3 Event Configuration

B Configuring Event Trigger
Click the @ button and select Event Trigger to configure the trigger out function of

the camera.

Event Server

__Address Book
Event Tri

0 Bvent Tzsor

Event > Event Trigger

Camera List Trigger Setting

GG Name | IP address | Port Add Address Book
1P CAM# 192168030 ED 0 smre Address Book List
Subject:

1. Onthe Event Trigger window, select the desired camera from the Camera List.
2. Do one of the following:
® SMTP: Select this option and enter the Subject and Message, the system will
send an email message to the selected user(s) in the Address Book List.
® Play Sound: Select this option select a sound file from the computer, so that

the system will alarm by the sound while triggering out.
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® eMap Popup: Select this option and select the eMap profile from the
pull-down menu. The camera view of the eMap will be displayed while
triggering out.

B Setting up Event Server
Click the @ button and select Event Server to configure the SMTP server, so that

you can send emails that include still images as notification.

Address Book

'Q.0).C

5 Event Server %]
Event > Event Server

sum
Ok SiiTE

SMTP Sener Adcress:

Sender Emai Adiress

Authentication Mode: @ None O SMTP
Sander User Name

Sonder Passwors

Port Numbsr =

osst

Save Cancel Remove

Select the Enable SMTP option to start the email service of the system. When you

enable the service, you have to complete the following settings.
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® SMTP Server Address: Enter the mail server address.
For example, mymail.com.

® Sender Email Address: Enter the email address of the user who will send the
email. For example, John@mymail.com.

® Authentication Mode: Select None or SMTP according to the mail server
configuration.

® Sender User Name: Enter the user name to login the mail server.

® Sender Password: Enter the password to login the mail server.

® Port Number: Enter the port number used for the email server.

When completed, click Save and then select OK. The system will automatically start the

Event Service.
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B Sending Notification to the User
Click the @ button and select Address Book to assign the user to the Address Book
of the camera. The user will receive a real-time notification from the system while

triggering out.

Event Server

Addre Boo

Event Trigger

(.0)

On the Address Book wi soe care

In the Address Book Informrauor nera, erner uie Nare ana erniair of uie User.

When completed, click Save. The user will be displayed in the Address Book List.

A 0N PR

To edit the user: In the Address Book List, select the desired user and click Modify.
The user’s information will be displayed, where you can change the user’'s
information and then click Save when completed.

5. To delete the user: In the Address Book List, select the desired user and click

Remove. The selected user will be removed from the list.
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5.4.4 Changing System Language

Click the @ button and select language to change the displayed system language.
On the Language screen, select the preferred language (English, Traditional Chinese,
or Simplified Chinese) and click Save.

Version

System Setting

o) Languege

System » Language

Please choose the user interface language:

© English

© Traditional Chinese

© Simplified Chinese

Save
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5.4.5 Terminating Operation

When you have finished operating, click the (D button and select Logout to logout
the system or Close to exit the program.
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5.5 Using IPFinder

IPFinder allows you to easily search the device, such as the Internet camera and video
server, within your network.

1. Click Start » Programs - UltraView Pro - IPFinder.

Alternatively, you can start the program by double-clicking the program icon on the
desktop of your computer.

|4 [FFinder (%]
gas Device Name Display the connected
92.168.0.30 camera 1 +| video server(s). Double
click to link the device.
I aou || ik || chengewp || scaren || meit | eeeees .

Click About to get the Version information of IPFinder.

Click Link to connect the selected device.

Click Change IP to modify the IP address of the selected device.
Click Search to find the IP address of the connected device(s).
Click Exit to close the utility.

2. Once you get the IP address of the device, launch the Web browser or UltraView

Pro to access your device.
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CHAPTER 6
Remote Live View

6.1 Overview

www.c4mi.com is a website which provides the essential functionalities for users to

manage their C4mi-licensed devices. Users can register, activate, control their devices

and effectively manage accounts through this website. The following user guide will

walk you through the steps you need in order to take full advantage of the functionalities

that the website has to offer.

6.2 Instructions
WEB: C4mi
6.2.1 User Registration

A) Logging In
Log on to www.c4mi.com.

B) First-time
User

If you are a first-time user, F?'E???,EE?"&?.Q }th ng_i‘ster button to register.

C) Registration Information
Enter your email, display name, and password in the pop-up dialog box.
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Language v

Register
Email :
Display Name :
Re-enter Password :
Register Cancel
AboutCdmi | TermsofUse | Privacy Policy | ContactUs
Copyright®2012 Oplink Communication Inc. ALl rights reserved

Enter a working email address. The system will display an error message if you enter an
email address that has already been registered or if you enter an invalid email address.
3.2

Enter a display name. Your display name can contain a combination of alphabetical and
numerical characters and can be no more than 20-character long.

3.3.

Enter and re-enter password. Password can contain alphabetical and numerical
characters and must be at least 6-chracter long. The length of your password cannot
exceed 20 characters.
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D) Successful Registration
Click on the Register button when you have entered all the required information. The

following webpage will appear to confirm your registration.

v

y
-

Registration is successful!

An instruction about the account activation has been sent ta you. Please check your email.

If you have not received the email, please go to the "Log In" page to log in, we will resend you the email.

T
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E) Account Activation Confirmation

Check the email which you have provided to C4mi upon registration. You will receive a
system-generated email message which contains an account activation link. Click on

the activation link and you will be directed to the following webpage which confirms your

account activation.

The account activation is successful!

Please go to the "Log In" page to log in

OK

AboutCami | Terms ofUse | Privacy Policy | ContactUs
Copyright®2012 Oplink Communication Inc. All rights reserved

Language

v
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6.2.2 Activating Devices

You can activate your device by entering the correct device activation code. Once your
device is successfully activated, you can start viewing the video image generated by
your device.

A) Activating Device
1. Click on the Activate Device button to start the device activation process.

Helcome whol B [Lenguage v

7 My Device 5 Account l  Delete Device

Getting Started!!

1 Step 1: Enter device activation code and verify the connection Y

Step 2 Activ

status

Start

AboutC4mi | TermsofUse | PrivacyPolicy | ContactUs
Copyri hA2DI2 Oplink Cosaunication Tnc. ALl rights reserved
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2.
Click on the Start button. As the following webpage has indicated, enter the device
activation code and click the Next button.

Welcome whotnew QRliligny | Language v

31 My Device " Account “ [ Delete Device

Step 1: Enter device activation code and verify the connection

Please connect the supplied Ethemet cable to your device and the router. Then

connect the power supply of the device.

Activation Code : Help : What is activation code?

Enter Activation Code

Next
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3.

The system will display the following webpage once the inputted activation code was
correctly entered. The system will display an error message if the activation code field is
left in blank or an invalid activation code is entered.

The Scsvadon of D Grvice (5 Sacceeshd

Yo £ G 10 My Qeyice e I name or CONSGUE your device
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6.2.3. My Device

A) Looking Up Devices

e Your device will be automatically added to My Device list once it is successfully
activated.

e Click on any of the device on the device list appeared on the left to view the

real-time image from the selected device.

e You can control the direction of the camera lens by clickingon A, ¥, <« or » buttons.

o Click on the Edit icon next to the camera name to edit the name of the device.

n Account | B ActivateDevice | Ml Delete Device

o Oplink lp-camera
o HUN

o WH Test Camera | |
o CS1330D2

o Global Sensing C
o AR9331 device 0!

o 052330

o SPORCH Meeting

o Camera BB

o 1330 Taipei

| I >
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Click on save to save the modification or click on cancel to cancel the edit process.

Il Delete Device

U

|
I»]

o Oplink Ip-camera
o HUN

o WH Test Camera |
o CS1330D2

o Global Sensing C

‘AR9331 device 0§

e

o 52330

@

SPORCH Meseting

‘Camera BB

)

o 1330 Taipei
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B) Viewing 8Video Images

Click on the [=;~ ] button to view up to 8 camera images at a time.

Welcome whol BT (Language

Y Account Delete Device

-

LB ! acy 1
Copyri O2012 Oplink Commumication Ine ALl rights reserved
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Click on any of the camera buttons to view a single video image. Click on the page
number to view the desired real-time video image(s). You can view up to 8 video
images per page and up to 16 from a total of 2 pages.

weicome. ot new KKK

My Device ! Account B Activate Device I Delete Device
5 [z

o :%ur:alasnsing "o AR9331 device 05 ‘9 ©s2330 £

SPORCH Meting,
Room =

i) CameraBC 9 1330 Taipei Office. 9 1330 Taipei
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Click on the D

button on the 8-video webpage to return to My Device webpage.

Weicome whot new (SIS

My Device ! Account % Activate Device I Delete Device

] 12
" !@Cﬁu_mgamansmg . o ARSI deice 05| i !ﬁ‘gﬁggpumm@
| o CameraBC | 9 1330 Taipei Office 9 1330 Taipei |
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C) Upgrading Your IPD
The red flag next to an IPD indicates that an IPD upgrade application is now available.

o

* Account & ActvateDevce  [] Delete Device

Click on the red flag icon and the system will display the following dialog box to confirm
your upgrade request.

Confirm upgrade IPD

Thig IPD nead 0 upgrade Are you sure updgrade

e Click on the “Yes” button to start the upgrading process. Your IPD status will be offline
while undergoing the upgrading process.

e The device will return to the online status once it has completed the upgrading
process. Click on the “NO” button to cancel the upgrade request.
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6.2.4. Setting Up Accounts
A) Account Information
Welcome whotnew [GHLoI i

T My Device \ a' Activate Device | ]  Delete Device

Account Information

IFyou will not change your passwird, jUst leave "0l Password', "New Passwart and "Re-enter Mew Password' empy.

Display Name : [wh new |

Old Passward : | |

New Password : | |

Re-enter New Password : | |

Update

1. You can update your display name and password by clicking on the Account tab.

2.

e Enter a new display name. Display name can include a combination of alphabetical
and numerical characters.

e Maximum length of your display name is 20 characters.

e The display name field cannot be left in blank; otherwise the system will generate an
error message.
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3. Password can be left in blank. Should you decide to reset your password, you may
include a combination of alphabetical and numerical characters and the length must be
at least 6-character long. The maximum length of your password is 20 characters.

4. Click on the Update button to complete your account updating process.

6.2.5. Deleting Devices
Click on Delete Device the webpage will display all the devices you are authorized to

view.
w Weicome whos  [MMACLU AN |Language v

3 My Device % Account 5 Activate Device 'H\[ Delete Device

Delete

(] Display Name Online Status
O Camera B6 Offiine
O device offtine
[m] device Offline

Check the box (es) next to the device(s) which you wish to delete. To delete all devices
displayed on the webpage, check the box next to Display Name.

1 My Device 5! Account & Activate Device Il Delete Device

Delete

O Display Name Online Status

Camera B8 offline

(e} W]

device Offiine

device Offline

ol
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After checking the box (es) next to the device(s) you wish to delete, click on the Delete
button. The system will pop up a confirmation dialog box. Click on the Delete button to
delete the selected device(s) or click on Cancel to exit the confirmation dialog box.

Display Name

device
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APP: EAGLESENSE

6.3 Operating Eaglesense

1. Please find “EagleSense” app from Andriod Google Play or iTune App Store and
download before using.

2. For the first-time user, if you haven't registered on C4mi, please go to www.c4mi.com.

to register.
3. If you already registered on C4mi, please use the same email address and password

to log in to EagleSense.

Andriod Google Play

> & ull @ © 3:23

@

B Apps < Q
EagleSense

E OPLINK COMM....

®

Tk kkk 4 Jul 17,2012
100+ downloads 1.61MB

EagleSense links people and IP Cameras
with real-time video. Users will have easy
access to all IP Cameras that have been
registered through EagleSense. Users can
also manage IP Cameras through C4mi open
cloud-bhased nlatform service.
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http://www.c4mi.com/

iTune App Store

Communications

Rated 4+

Requircments:

Compatible with iPhone, iPod
touch and iPad.

Requires i0S 4.2 o later.

App Support

More Apps by Oplink
Communications Inc.

Seek Sense
Utilitios

N
OPLINK
N

EagleSense (Q eaglesense
Oplink Communications Inc. Developer Page >
EagleSense Tell A Friend >

Description

EagleSense links people and IP Cameras with real-time video and is currently
released with iPhone and iPad versions. Users will have easy access to all IP
Cameras that have been registered through EagleSense. Users can also manage
IP Cameras through C4mi open cloud-based platform service.
More ¥

What's New in Version 1.7.3  Updated 21 June 2012

1) Fixed a eritical bug in which user cannot sign in successfully due to Server IP
change

2) Announcement will be displayed on Sign-In and Single-Video interface when
server is down or going to be shut down.

Eaglesense
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6.3.1 Logging In
Open EagleSense application login page. Enter account User ID, password then tap the
Sign in button to log in to the system. (User ID and password are the same as your

registered C4mi account) Tap on HELP on the bottom right hand corner to enter C4mi
website Help link.

No SIM = 3:37 PM 3 -

EagleSense

Sign in

1.7 HELP
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6.3.2 Viewing Videos

A) Start Viewing Videos
On the camera list, tap the camera from which you wish to view the desired image.

Oplink3

v

h
o
2
=
&
C oo

o
=)
§ =n

=

«
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B) Pinch to Zoom

Touch your iPhone screen with two fingers. Close two fingers to zoom in and open two
fingers to zoom out the image you wish to enlarge or shrink. The frame at the bottom left
corner exhibits the displayed area of the image.

Cplink2
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C) Moving Images Around
When the image is in zoom mode, drag the displayed image to your preferred

location. The frame at the bottom left corner exhibits the current image movement.

Oplink3

Qplink3
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D) Stop Viewing Videos

Tap the E button at the bottom right corner to exit the video viewing page and return

to the device list page.

~" Mazke sure everything
P

Oplink3

s oplink1

L4 oplinkz
e ophink3
L4 oplink4

v ophnkS

- TE- T I

% oplinké
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E) Updating Device Information

Tap the icon of the camera to which you wish to update information, and you will be

directed to the device info page. Enter the desired information to update the device info.
Tap the Save button to save the inputted information.

.« oplink1
o4 oplink2
o4 oplink3

.4 ophnkd

g Q2 D o %

o oplinkS

* oplinké

Cevice Mame

aplirk
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6.3.3 Viewing Images Generated from Multiple Videos

EagleSense Application allows you to view up to 4 videos on your iPhone and 8 on your
iPad. You will operate iPad the same way you operate your iPhone. The following steps
walk you through the set up process needed in order to view multiple video images from
your iPhone.

A) Viewing 4Video Images

e Tap the Video button at the bottom of your iPhone screen.

e The following 4 video images will appear (The system displays the images from the 4
cameras you previously selected.)

e Tap any of the 4 images and the screen will display the image which you

selected.
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B) Viewing 8Video Images

e Tap the Video button at the bottom of your iPad screen.

o A maximum of 8 video images will appear (the system displays the images from the 8
cameras which you have previously selected.)

e Tap any of the 8 images and the screen will display the video image which you
selected.

opink3
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C) Viewing More Videos
Swipe the screen to view more videos.

N¢ Video

N Viceo
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D) Changing the Displayed Location of the Selected Video
If you wish to change the displayed location of a particular video image, simply press
down the image and drag it to your preferred location.
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E) Offline Cameras

When you attempt to view an image from an offline camera, a message will appear to
indicate that the image is currently unavailable due to camera’s offline status. When you
press down the camera to show the single image, the screen will display the same
message. (As shown below)

o M 5

RNE T Mo Vidad
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6.3.4 Exiting EagleSense
Return to the device list page.

Tap the n icon to exit EagleSense Application.
Mo SIM = 10:58 AM i &=

L4 oplink1
L4 oplink2
L+ oplink3

L4 oplink4

o0 e o

[« oplink5

3

st e

* oplink6
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6.4 Frequently Asked Questions

6.4.1 The webpage cannot be displayed, what should |1 do?
For your c4mi webpage to be normally displayed, you need Firefox 11.0 or above, IE 8
or above, or Chrome 12.0 or above.

6.4.2 | forgot my password, how can | reset one?

1. Log on to www.c4mi.com and click on the Forget Password button.

2. In the Forgot your password pop-up dialog box, enter the email address which you
have provided to C4mi upon registration. Click on Send button after you have made
sure that you have entered the correct email address.

Language v

ur account, and an instructic

Email

Send Cancel

AboutCdmi | TermsofUse | PrivacyPolicy | ContactUs

Copyri ght®2012 Oplink Conmunication Inc. All rights reserved
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3. Check the email address you used to register and you should receive an email

message which contains the password reset link. Click on the link and you will be

taken to the following password reset dialog box. Start resetting your password.

Reset your Password

To resetyour password, please enter your new

New Pas:

Re-enter Pas:

sword :

Send

AboutCdmi | TermsofUse | Privacy Policy | ContactUs
Copyright®2012 Oplink Conmunication Tne. ALl rights reserved

Language

vi|

107



4. Enter and re-enter your new password.

The passwords must match; otherwise the system will generate an error message. Click
on the Send button.

5. The following webpage indicates that you have successfully reset your password.

Update Success

Your password has been successfully updated

AboutCd4mi | TermsofUse | Privacy Policy | ContactUs

Copyright®2012 Oplink Conmunication Inc. All rights reserved

6. You may now log in with your newly setup password.

6.4.3 How do | download user client?

Log on to www.c4mi.com to access the website.

You may download Eaglesense App from App store if your device runs on iOS. For
Android 2.2 or above users: You may download EagleSense App from Google Play.
Eaglesense does not support Android 2.1 or below.
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CHAPTER 7

APPENDIX.

Glossary of Terms

NUMBERS
10BASE-T

100BASE-TX

ADPCM

AMR

Applet

ASCII

ARP

AVI

BOOTP

10BASE-T is Ethernet over UTP Category Ill, IV, or V unshielded
twisted-pair media.

The two-pair twisted-media implementation of 100BASE-T is called
100BASE-TX.

Adaptive Differential Pulse Code Modulation, a new technology improved
from PCM, which encodes analog sounds to digital form.

AMR (Adaptive Multi-Rate) is an audio data compression scheme
optimized for speech coding, which is adopted as the standard speech
codec by 3GPP.

Applets are small Java programs that can be embedded in an HTML page.
The rule at the moment is that an applet can only make an Internet
connection to the computer form that the applet was sent.

American Standard Code For Information Interchange, it is the standard
method for encoding characters as 8-bit sequences of binary numbers,
allowing a maximum of 256 characters.

Address Resolution Protocol. ARP is a protocol that resides at the TCP/IP
Internet layer that delivers data on the same network by translating an IP
address to a physical address.

Audio Video Interleave, it is a Windows platform audio and video file type,

a common format for small movies and videos.

Bootstrap Protocol is an Internet protocol that can automatically configure
a network device in a diskless workstation to give its own IP address.
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Communication

Connection

DHCP

DNS

E

Enterprise network

Communication has four components: sender, receiver, message, and
medium. In networks, devices and application tasks and processes
communicate messages to each other over media. They represent the
sender and receivers. The data they send is the message. The cabling or
transmission method they use is the medium.

In networking, two devices establish a connection to communicate with
each other.

Developed by Microsoft, DHCP (Dynamic Host Configuration Protocol) is a
protocol for assigning dynamic IP addresses to devices on a network. With
dynamic addressing, a device can have a different IP address every time it
connects to the network. In some systems, the device's IP address can
even change while it is still connected. It also supports a mix of static and
dynamic IP addresses. This simplifies the task for network administrators
because the software keeps track of IP addresses rather than requiring an
administrator to manage the task. A new computer can be added to a
network without the hassle of manually assigning it a unique IP address.
DHCP allows the specification for the service provided by a router,
gateway, or other network device that automatically assigns an IP address
to any device that requests one.

Domain Name System is an Internet service that translates domain names
into IP addresses. Since domain names are alphabetic, they're easier to
remember. The Internet however, is really based on IP addresses every
time you use a domain name the DNS will translate the name into the
corresponding IP address. For example, the domain name
www.network_camera.com might translate to 192.167.222.8.

An enterprise network consists of collections of networks connected to
each other over a geographically dispersed area. The enterprise network
serves the needs of a widely distributed company and operates the

company’s mission-critical applications.
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Ethernet

F
Fast Ethernet

Firewall

G
Gateway
Group

HEX

|
Intranet

The most popular LAN communication technology. There are a variety of
types of Ethernet, including 10Mbps (traditional Ethernet), 100Mbps (Fast
Ethernet), and 1,000Mbps (Gigabit Ethernet). Most Ethernet networks use
Category 5 cabling to carry information, in the form of electrical signals,
between devices. Ethernet is an implementation of CSMA/CD that

operates in a bus or star topology.

Fast Ethernet, also called 100BASE-T, operates at 10 or 100Mbps per
second over UTP, STP, or fiber-optic media.

Firewall is considered the first line of defense in protecting private
information. For better security, data can be encrypted. A system designed
to prevent unauthorized access to or from a private network. Firewalls are
frequently used to prevent unauthorized Internet users from accessing
private networks connected to the Internet, especially Intranets all
messages entering or leaving the intranet pass through the firewall, which
examines each message and blocks those that do not meet the specified
security criteria.

A gateway links computers that use different data formats together.
Groups consist of several user machines that have similar characteristics
such as being in the same department.

Short for hexadecimal refers to the base-16 number system, which consists
of 16 unique symbols: the numbers 0 to 9 and the letters A to F. For example,
the decimal number 15 is represented as F in the hexadecimal numbering
system. The hexadecimal system is useful because it can represent every
byte (8 bits) as two consecutive hexadecimal digits. It is easier for humans to
read hexadecimal numbers than binary numbers.

This is a private network, inside an organization or company that uses the
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Internet

Internet address

IP address

ISP

JAVA

same software you will find on the public Internet. The only difference is
that an Intranet is used for internal usage only.

The Internet is a globally linked system of computers that are logically
connected based on the Internet Protocol (IP). The Internet provides
different ways to access private and public information worldwide.

To participate in Internet communications and on Internet Protocol-based
networks, a node must have an Internet address that identifies it to the
other nodes. All Internet addresses are IP addresses

Internet Protocol is the standard that describes the layout of the basic unit
of information on the Internet (the packet) and also details the numerical
addressing format used to route the information. Your Internet service
provider controls the IP address of any device it connects to the Internet.
The IP addresses in your network must conform to IP addressing rules. In
smaller LANs, most people will allow the DHCP function of a router or
gateway to assign the IP addresses on internal networks.

IP address is a 32-binary digit number that identifies each sender or
receiver of information that is sent in packets across the Internet. For
example 80.80.80.69 is an IP address. When you “call” that number, using
any connection methods, you get connected to the computer that “owns”
that IP address.

ISP (Internet Service Provider) is a company that maintains a network that
is linked to the Internet by way of a dedicated communication line. An ISP
offers the use of its dedicated communication lines to companies or
individuals who can’t afford the high monthly cost for a direct connection.

Java is a programming language that is specially designed for writing
programs that can be safely downloaded to your computer through the
Internet without the fear of viruses. It is an object-oriented multi-thread
programming best for creating applets and applications for the Internet,
Intranet and other complex, distributed network.
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LAN

MJIPEG

MPEG4

NAT

Network

NWay Protocol

Local Area Network a computer network that spans a relatively small area
sharing common resources. Most LANs are confined to a single building or
group of buildings.

MJPEG (Motion JPEG) composes a moving image by storing each frame
of a moving picture sequence in JPEG compression, and then
decompressing and displaying each frame at rapid speed to show the
moving picture.

MPEG4 is designed to enable transmission and reception of high-quality

audio and video over the Internet and next-generation mobile telephones.

Network Address Translator generally applied by a router that makes many
different IP addresses on an internal network appear to the Internet as a
single address. For routing messages properly within your network, each
device requires a unique IP address. But the addresses may not be valid
outside your network. NAT solves the problem. When devices within your
network request information from the Internet, the requests are forwarded
to the Internet under the router's IP address. NAT distributes the responses
to the proper IP addresses within your network.

A network consists of a collection of two or more devices, people, or
components that communicate with each other over physical or virtual
media. The most common types of network are:

LAN — (local area network): Computers are in close distance to one
another. They are usually in the same office space, room, or building.
WAN - (wide area network): The computers are in different geographic
locations and are connected by telephone lines or radio waves.

A network protocol that can automatically negotiate the highest possible
transmission speed between two devices.
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PCM (Pulse Code Modulation) is a technique for converting analog audio
signals into digital form for transmission.

Packet Internet Groper, a utility used to determine whether a specific IP
address is accessible. It functions by sending a packet to the specified
address and waits for a reply. It is primarily used to troubleshoot Internet
connections.

Point-to-Point Protocol over Ethernet. PPPOE is a specification for
connecting the users on an Ethernet to the Internet through a common
broadband medium, such as DSL or cable modem. All the users over the
Ethernet share a common connection.

Communication on the network is governed by sets of rules called
protocols. Protocols provide the guidelines devices use to communicate
with each other, and thus they have different functions. Some protocols are
responsible for formatting and presenting and presenting data that will be
transferred from file server memory to the file server’s net work adapter
Others are responsible for filtering information between networks and
forwarding data to its destination. Still other protocols dictate how data is
transferred across the medium, and how servers respond to workstation
requests and vice versa. Common network protocols responsible for the
presentation and formatting of data for a network operating system are the
Internetwork Packet Exchange (IPX) protocol or the Internet Protocol (IP).
Protocols that dictate the format of data for transferors the medium include
token-passing and Carrier Sense Multiple Access with Collision Detection
(CSMA/CD), implemented as token-ring, ARCNET, FDDI, or Ethernet. The
Router Information Protocol (RIP),a part of the Transmission Control
Protocol/Internet Protocol (TCP/IP) suite, forwards packets from one

network to another using the same network protocol.

RJ-45 connector is used for Ethernet cable connections.
A router is the network software or hardware entity charged with routing

packets between networks.
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RTP (Real-time Transport Protocol) is a data transfer protocol defined to
deliver live media to the clients at the same time, which defines the
transmission of video and audio files in real time for Internet applications.
RTSP (Real-time Streaming Protocol) is the standard used to transmit
stored media to the client(s) at the same time, which provides client
controls for random access to the content stream.

It is a simple computer that provides resources, such as files or other
information.

SIP (Session Initiated Protocol) is a standard protocol that delivers the
real-time communication for Voice over IP (VoIP), which establishes
sessions for features such as audio and video conferencing.

The Simple Mail Transfer Protocol is used for Internet mail.

Simple Network Management Protocol. SNMP was designed to provide a
common foundation for managing network devices.

In LANSs, a station consists of a device that can communicate data on the
network. In FDDI, a station includes both physical nodes and addressable
logical devices. Workstations, single-attach stations, dual-attach stations,
and concentrators are FDDI stations.

In TCP/IP, the bits used to create the subnet are called the subnet mask.

Transmission Control Protocol/Internet Protocol is a widely used transport
protocol that connects diverse computers of various transmission methods.
It was developed y the Department of Defense to connect different
computer types and led to the development of the Internet.

A transceiver joins two network segments together. Transceivers can also
be used to join a segment that uses one medium to a segment that uses a
different medium. On a 10BASE-5 network, the transceiver connects the
network adapter or other network device to the medium. Transceivers also
can be used on 10BASE-2 or 10BASE-T networks to attach devices with
AUI ports.
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The User Datagram Protocol is a connectionless protocol that resides
above IP in the TCP/IP suite

The USERNAME is the unique name assigned to each person who has
access to the LAN.

It is a program that performs a specific task.

Unshielded twisted-pair. UTP is a form of cable used by all access
methods. It consists of several pairs of wires enclosed in an unshielded
sheath.

Wide-Area Network. A wide-area network consists of groups of
interconnected computers that are separated by a wide distance and
communicate with each other via common carrier telecommunication
techniques.

WEP is widely used as the basic security protocol in Wi-Fi networks, which
secures data transmissions using 64-bit or 128-bit encryption.

Windows is a graphical user interface for workstations that use DOS.
WPA (Wi-Fi Protected Access ) is used to improve the security of Wi-Fi
networks, replacing the current WEP standard. It uses its own encryption,
Temporal Key Integrity Protocol (TKIP), to secure data during transmission.
Wi-Fi Protected Access 2, the latest security specification that provides
greater data protection and network access control for Wi-Fi networks.
WPA2 uses the government-grade AES encryption algorithm and IEEE
802.1X-based authentication, which are required to secure large corporate
networks.
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